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GLOWING SHROOMS INTRODUCTION

Obviously none of the above is real, there are no faires and the forest fungi don't glow at night.
But one thing I have learned whilst shooting 'Glowing Shrooms' is you need to have an
imagination. Although it is very technical, you'll be crawling around on your knees and shooting
multiple images to focus stack and blend whilst illuminating fungi, it is fun and very creative.

Deep in the forest there is a magical world hidden from prying eyes which comes alive at night.
When all is quiet the Shrooms, dormant all year, start to glow. 

Why they glow is a mystery, is this how they communicate with each other? Or perhaps it is an
ancient skill they evolved from days long ago to help the other inhabitants of the forests at
night, the fairies and the creatures of legend long since vanished. Or have they?
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How is it creative? Whilst combining the skills of macro photography you are also creating a
mood and telling a story. You will be turning day into twilight, using the characteristics of your
macro lens to create wonderful backgrounds and bokeh highlights, using light of course, using
colour and white balance to create the mood you want, and creating a magical world to
enchant your viewers. And most of this you'll �nd very local to you. It just takes the time to get
out there to your local woods and try. 

All the gear you need, with tips on types of lighting and tripods, plus tips on other essential
accessories you probably had not though about to make your shooting experience just a little
easier such as brackets for holding torches and a �oor mat for your knees, essential if your bones
are starting to creak like mine.

Tips and techniques for how to illuminate shrooms. This is one of the most important aspects of
Glowing Shrooms, with different techniques.

BE CREATIVE

How to shoot the images, focus bracketing and settings, shooting additional sets illuminated,
and being creative with backgrounds.

Step by step processing your images, from stacking your focus bracketed images to blending
them into a �nal images. Although this is using Lightroom and Photoshop any image processor
can be used and other alternatives such as Af�nity Photo can be used to blend the images
together.

Through this tutorial I will take you though step by step the gear you need, the technique of
shooting Glowing Shrooms and illumination techniques, the processing steps of combining
images into a �nished shot, and some other examples of my own to help give you inspiration.
Read on and I will you every success. 

1 RECOMMENDED GEAR

2 ILLUMINATING SHROOMS

3 SHOOTING TECHNIQUES

4 PROCESSING

Although I shoot primarily with Olympus cameras (plus a Nikon Z7 and Sigma FP) this guide is
suitable for all camera brands. For this reason I've made it very generic for a wider audience. Any
camera that can focus bracket will be suitable, however if you do use Olympus you will �nd a
dedicated section under 'Olympus Settings'.
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A selection of images with descriptions on how they were taken and illuminated to give you
further ideas in your quest for 'Glowing Shrooms'.

Although this guide is not speci�c to any brand, indeed any camera can be used which will focus
stack, this section includes tips and tricks for Olympus shooters, including which settings to use
and buttons to set. Learn how to enable focus bracketing, which settings to use, how best to
focus, plus a few other tricks and advice on how to save settings for your next session.

5 INSPIRATION

6 OLYMUS SETTINGS
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RECOMMENDED GEAR

Using the right gear is obviously essential and whilst things like bags are very personal I can at
least give a few pointers in what to look for, you may get a few tips or see something you
haven't considered. There are tips for tripods, macro lights and a few accessories you may �nd
useful too. These are all items I own and use so I feel quali�ed being able to recommend them.

It does seem pretty foolish listing a camera as essential gear, but yes you'll need a camera.
Without being speci�c about brand or requirements there are a few prerequisites that are
needed.

CAMERA

It will need the ability to focus bracket, where the camera will shift the focus over a number of
frames you program in. Whilst it is pretty standard these days that are some that do not have
the ability so please check. Normally Focus Bracketing is enabled and a number of frames can
be set from 3-999, with steps (or distance) set between each frame from 1-10. Frames are saved
as RAW as opposed to Jpeg for processing and stacking later. Some cameras have in camera
Focus Stacking which will produce a Jpeg image, but we will stick to using RAW for more
�exibility. 

1) Focus Bracketing 
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Extension tubes are primarily for shorter lenses and range in quality (Kenko and Fotodiox being
amongst the best third party) and they are available with electronic contacts to maintain Auto
Focus. Manual extension tubes for our purposes are really not worth trying. 

You will also need an external shutter release port so do check. It is important not to touch the
camera to avoid camera shake and the best way is to use a cable release. If you don't have a
port perhaps you can use a wireless trigger such as the Pluto Trigger. It is worth checking. In
many instances you will not be able to use the Self Timer because Focus Bracketing will disable
the option to use it.

3) External Shutter Release Port 

Macro For Bokeh 
Another essential and very important piece of equipment is a good Macro lens. For really small
Shrooms it's important to be able to get close with a close focus distance and sometimes 1:1
magni�cation. What really matters is a fast aperture of f2.8 which will create beautiful
background bokeh, those soft round out of focus highlights, and creamy soft out of focus areas
which you can use creatively. 

 
You really do need an articulated screen, that is a screen that will �ip out. As most images are
going to be taken at low Leven the ability to �ip the screen out when the view�nder is very hard
to access is a must. If your screen only �ips out in landscape as with the Nikon Z7 at least you
will be able to produce landscape format images.

2) Articulated Screen

MACRO LENS

I would tend to go with around 100mm focal length as an ideal. It isn't too long, meaning you
can still view the screen and hold a �ashlight over the subject when needed if you have a larger
shroom in the frame. The Olympus has a closest focus of 19cm whilst the Nikon is 29cm and
Canon 26cm. 

If you don't have a macro lens you can still try although you do need to be able to focus quite
close and have a fast aperture to be able to throw the background completely out of focus; good
separation between the subject and background really is key. Extension tubes that reduce the
closest focus distance may be an option worth a try, as are close focus lenses. 
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For longer lenses close focus lenses such as the NiSi Macro Lens or Raynox Macro Lens are add
on glass elements. If you don't want to invest in a macro lens just yet an extension tube or add-
on macro lens may be suitable, but check how close you can focus and check the extension
tube will still allow focus stacking with your camera.

The Giga T Pro has been around a long time now and is half the price it used to be, around £30.
Although the built in intervalometer is a little redundant now because so many cameras have it
built in, it is a very reliable and easy to set up wireless trigger with a long range too of 100m. The
transmitter �ts to the hot-shoe and connects to the camera a cable, which can be connected
direct to the trigger to use as a standard wired release. Other cables are available for different
cameras too. I have one of these but prefer the Pluto because only one battery is needed.
Remember to switch the receiver off. 

HANNEL GIGA T PRO II 

 
The king of wireless triggers, and compatible with a huge range of cameras via suitable cables.
The transmitter unit is rechargeable which is very convenient. Operated by a phone App there is
little this little thing cannot do which makes it ideal to use for multiple cameras. This device will
trigger a shot when it sees lightning, it can exposure bracket up to 19 shots, shoot star trails,
trigger a shot by sound, or by the included laser beam, run time-lapses and a host of other
features, too many to mention. What it cannot do is Focus Bracket because the settings are in
camera, but it can be used to start the sequence off. It isn't cheap at around £120, but it may be
worth considering if the other features are appealing.

PLUTO WIRELESS TRIGGER

 
My preferred option, the image is a Pixel remote from Amazon costing £8. For my Olympus
camera an E3 jack which is the same as Canon is all I need. Cheap and cheerful, I have a habit of
losing them or sending them swimming when they dangle under the camera. There are plenty
available, just get the right connector for your camera. I prefer these because they are nothing
but a button on the end of a cable with an electrical contact and have no batteries, so one less
thing to have to charge before a trip out. 

WIRED CABLE RELEASES

RELEASES AND TRIGGERS
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As someone who has owned and still owns too many tripods I'm pretty well quali�ed to advise.
With the amount of image stabilisation in camera bodies these days tripods seem less
important, but they are. By all means enjoy the freedom of shooting hand held, I do more and
more. But a tripod is still needed for Long Exposures, Bracketing (although it can easily be done
hand held too) Panoramic images, and Macro. 

TRIPODS

The main point of a tripod which is overlooked is to slow you down. Consider the scene and your
composition, take your time, make adjustments and wait for the light. There are hundreds to
choose from, and an old addage still remains true today, tripods can be cheap, sturdy or light;
pick two because you can't have all three.

The main features to look out for on a tripod are maximum height, weight, strength, and Arca
Swiss compatibility. Maximum height excluding the centre column is important for �exibility,
weight is obvious but going for the lightest is often false economy because a few extra grams
really won't matter. Strength doesn't mean load capacity, the more stable and solid it is the
more it will resist vibration. Arca Swiss heads give more freedom of accessories such as L
Brackets.

 
This is not a bad tripod at all and is very useful for macro. It has a centre column which can be
�ipped over to use as a boom arm which is handy for getting low and extending reach. One
thing to be aware of with tripods such as this is the centre column needs to be level (ish)
horizontally or you will not be able to maintain a level horizon because of restrictions in
movement of the ball head. A level horizon sometimes doesn't matter if there isn't a horizon,
but it's best to be aware. I get around this by swivelling the centre column 180 degrees so it is
upside down and using an L bracket. This way I can achieve full control of positioning, I can get
right down to the forest �oor so it is almost resting on it but with solid support, and I can have
the camera the right way up. You could do the same with a standard tripod if the centre column
will reverse. 

1) VANGUARD ALTA PRO 2
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For more budget friendly tripods including aluminium and carbon �bre you really cannot beat
K&F. I use this model the KF09 aluminium 170cm. Very similar to the Vanguard it has a centre
column which will �ip over like a boom arm, but be aware annoyingly this arm is an additional
column housed inside the centre column, in other words extend the arm and the centre
column is still in place which restricts how low you can get. But the column can reverse and
extend so it still has considerable �exibility. It is more of a faff to reverse the column, but with
different sizes and options from around £100 including the ball head they are very good value
and worth checking out.

2) K AND F TRIPODS

The 1K is around £30, the 3K £60 but it is worth going for the 5K because the ball-head is far
better and it is Arca Swiss so a standard tripod plate will �t as will an L Bracket. I had the 3K but
ended up buying the ball-head separately for the Arca compatibility.

The Alta Pro at around £200 isn't bad value. There is an older version with the same features,
the Alta Pro, at around £50 less, and a newer version at around £250, the Alta 3. The new version
has an additional bracket which can be clamped onto the centre column for attaching
additional accessories such as lights, or another ball head. I am very happy with the Alta Pro 2, it
suits all my needs but do check out the options, there will be one to suit you.

GORILLAPOD
There are quite a few bendy tripods available these
days but the Joby is still the original and best. Useful
because they are so small and light and easily �t into
a backpack side pocket, and they are great for getting
really low or for wrapping around tree trunks, walls
and fences etc. 

With the bendy legs you can get very low, and it's
useful to support other accessories too such as a torch
using an additional clamp or Macro lights like the
Adaptalux below.

Prices of these lately seem to have gone through the roof, so shop around, and alternatively get
the legs and a third party ball head, Smallrig produce small ball heads that are very good for
around £20.
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CAPTURE CARD
Using a capture card allows you to turn a mobile
phone (Android only) into an external screen, useful if
your screen isn't fully articulated and when you have
problems viewing the screen and setting up lights.
This one was £17 on Amazon. 

Your camera needs a video-out port which most have
these days, and you'll need an HDMI cable. Check you
camera to see what connection you need on the other
end.

It will only work with Android because iPhones block video in settings. You'll also need a phone
app called USB Camera Pro. The screen won't allow settings to be change but it is still useful to
use purely as a viewing monitor. See the Shooting page for more information.

L BRACKETS
An L Bracket is one of the most useful accessories you
can have and I always use one no matter what I am
doing. And as I said above if you need to reverse your
tripod centre column using an L bracket will allow to
angle the ball head and shoot at ground level in
landscape mode without the camera being upside
down. 

The 3 Legged Thing Ellie is one of the most popular
but there are so many, make sure you use one that �ts
your camera and if your screen is articulated it has a
cut out to allow the screen to be angled up. There's
also a wide range of prices too so shop around and get
one to suit your needs.



11

INIU POWER BANK
A power bank is useful if you intend being out for
quite some time feel you may need power on the go.
The INIU is compact, 20,000mAh and 22.5w meaning
it has plenty of capacity with x2 USB 3 and 1 USB C
ports.

It was also reasonably priced at £26. The USB C port is
in/out so it can be charged and also charge from the
same port. An LCD screen shows power and it also has
a torch too. Many cameras can be charged on the go
too as long as the power bank is PD rated which this
one is.

My favourite LED torch because its so small at only 10cm long, and it packs power at 2000
lumens. Brightness is adjustable but it doesn't have adjustable beam which for me doesn't
matter, being so small works better. It is rechargeable via a usb magnetic cap which clips on the
end. My main criticism of this is on full power it will last for 10-20 seconds before dimming to the
next power level down to conserve battery, but it's long enough and it will last a full session, so I
guess it's actually a good thing. 

NEBO TORCHY 2K 

It goes without saying a critical part of the Glowing Shrooms image gathering process is
illumination. I have used quite a few different techniques and �ashlights, some which work well,
some not so well. Below are the the items I �nd most useful. I will nearly always try to illuminate
from above when the 'glow' looks more realistic, so a few different lights are useful. Sometimes
shrooms are just too dense so a softer light from underneath can work with some care.

ILLUMINATION
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LED and rechargeable, handy when you have a battery pack, it will last quite a few uses
between charges and my experience is it has never lost charge when not in use. At 220 lumens
it's very bright for a head torch, light weight and has an adjustable beam width, adjustable
angle and also adjustable brightness levels. A head torch is probably something you already
have and they are handy if you want some soft lighting from below.

LED LENSER HEAD TORCH 

There are times when low power is enough but also times when the density of a shroom will not
transmit any light so a high power blast is needed. It is very good and I love how small it is. At
around £30 it isn't the cheapest but I've learned to avoid cheap, they are usually poor quality.

NEBO INSPECTOR RC
This is a handy little torch, because the head is only
10mm diameter it's useful for smaller shrooms and
the head also has a screw zoom feature so the beam
can be controlled. Rechargeable but also accepting
AAA batteries just in case, it has different power levels
up to 350 lumens so it is ideal.

PIXEL LED PANEL LIGHT
Small LED panels lights are useful for adding a little
glow under larger shrooms, or adding a little
background glow. You don't need a large one, just a
small 12cm one like the Pixel is enough. There are so
many to choose from, I like the Pixel because it has
brightness control from 0 to 1500 lux and a full range
of colours too. It's also very robust with an aluminium
body, easy to use controls, an arm which swivels out
and includes hot and cold shoe adapters.



13

Why they glow is a mystery, is this how they communicate with each other? Or perhaps it is an
ancient skill they evolved from days long ago to help the other inhabitants of the forests at
night, the fairies and the creatures of legend What on earth, you are probably thinking. A friend
recommended these to me and they are genius for lighting Macro Images. 

They are not cheap at around £300 for a kit with two lights, but they are worth the investment.
A tripod bush on the base allows it to be tripod mounted or used on a GorillaPod.

ADAPTALUX MACRO LIGHTS

Instead of being behind the camera trying to run focus bracketing and stretching trying to hand
hold a torch (see 'Focus Bracketing') or using a clamp, these bendy LED arms are powered by a
control unit and can accept up to 5 arms. The whole set is controlled by a phone app which just
uses Bluetooth so doesn't rely on a mobile signal, or with manual control. Light intensity can be
controlled as can the beam angle.
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It's surprising just how useful these are for an extra pair of hands holding a torch in position or
even a fern leaf in a background when your arms are not long enough. Sometimes you will
need to move a torch around a little taking a few shots to blend, other times especially when
you have a group of shrooms and you want to illuminate them precisely one at a time being
able to hold a torch in position leaving you hands free can be a bonus.

A short arm clamp, the Puluz arm is fully articulated. With one of these you'll realise just how
useful they are, for example clamp it onto a tripod leg, mount a phone holder to it and then �lm
a video or time lapse leaving your tripod head free for your camera. 

PULUZ ARTICULATED CLAMP 

CLAMPS

This arm extends by 11" with a fully articulated arm and a clamp which can be screwed onto
either end. This particular item includes an extender with a cold shoe mount (the square piece
at the top). Unscrew it and a tripod plate can be �tted to mount onto your Gorillapod or other
tripod. 

SINVITRON MAGIC MONITOR ARM 

The tripod plate is shown just as a reminder that an extra one is needed if you don't have a
spare so that the arm can be �tted to a tripod ball head. Most tripod plates have a treaded
section in the slot to allow the bolt to be screwed in, so the arm can simply be screwed into that.
If not just use the extender on the arm which is female threaded on both ends. Search on
Amazon for these, there are many and they are inexpensive. The short Puluz was £8 when I
bought one and the Sinvitron £15.

TRIPOD PLATE 
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Those shrooms can get very dirty so an air blower is useful to remove debris. Just a small
inexpensive one will do, I also got some small brushes too, but struggled to �nd them until I
realised searching on Amazon for Keyboard Cleaning Brushes did the trick. Just be careful,
some really delicate shrooms are easy to damage so you may just have to put up with some of
the smaller specks of dirt. 

 
Really useful when you've tried to reposition a shroom and �nd it is just on the wrong angle, a
few pins and a bit of wire can do the trick. I have a small bag in my backpack for bits and pieces
where I keep bits like this. Remember to cut a few pieces of wire �rst, you're unlikely to �nd any
scissors in the forest.

Essential, considering you don't know which shrooms are safe and which are not. Most in the UK
are safe and some poisonous if ingested, with the Death Cap being the most deadly. The Death
Cap is white and quite common, so after handling any shrooms it's best to sanitize your hands
afterwards. A travel size water free bottle is all you need, but make sure you have one with you.

CAMERA AIR BLOWER

FLORIST WIRE - GLASS HEAD PINS

HAND SANITIZER 

Finally, a few bits you may not have thought of which are useful and very easy to obtain just
about anywhere. You may already have these at home.

A FEW BITS

KNEE PAD
A folding mat for your knees really is a good idea. This one
was £7 on amazon and it really has saved my poor old knees
from unnecessary pain and getting soaking wet. It's approx
only A3 size and folds up to �t in a camera bag.
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ILLUMINATING SHROOMS

When creating 'Glowing Shrooms' we are usually setting a mood and creating an image that
appears to have a shroom glowing as if it has an internal light source which can be challenging.
We need to hold the light, get the right angle and take the images, ensuring it looks natural
whilst not moving the camera at all. 

AMBIENT LIGHT

You may not necessarily want to illuminate every image with a glow effect, sometimes just
adding a little ambient light creates a wonderful result.

An LED panel light on a separate tripod was
positioned to the side and to the rear of the
subjects with the light set to give a warm glow,
ensuring that the light did not shine into the
lens and create any lens �are. The intensity of
the light can be set as desired whilst also using
the camera controls to get the exposure as I
wanted. Note the out of focus background
created by using f2.8 and focus bracketing.

The setup, tripod set at low angle with a panel light.
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Note the K and F tripod with the centre column reversed to get low. An L bracket on the camera
means I can get the camera right down to ground level when needed with good support. The
slider is a Nisi Macro Slider which can also be useful although I admit I do not often �nd the
need to use it.

ILLUMINATING FROM ABOVE

Of course you can mix additional ambient light with additional 'glow' lights. This image again
used an external LED panel light to add a little side light set to a warm tone just to open the
shadows slightly for the �rst set of images. 
An additional set of images were taken with just one of the shrooms illuminated from above
with a hand held torch and the two sets of images once stacked are then blended together to
create one image.
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Illuminating from above is I feel the best way to create the effect of 'glowing' shrooms. For this
image I used the Adaptalux lighting set with two arms mounted onto a Gorillapod. Each arm is
positioned to get the glow effect through the top of the shrooms, leaving my hands free to
concentrate on gathering the sets of images. 

Of course you could also do the same just using one torch, hand holding or by using one of the
clamps shown in the gear section. In this case you would need to illuminate one, take a set of
images, then illuminate the other and take an additional set of images. It is more work but it is
entirely possible to do. I produced two images for this session, a portrait and a landscape and
then felt the landscape was preferable.

Adaptalux lights used mounted to a Gorillapd

Illuminating more than one shroom in an image is best done one at a time if you only have one
light source. There may be times when you can illuminate both at the same time with just one
torch but in this case the shroom on the left overlaps the shroom on the right so there would
have been a shadow. 

It does result in more images and more processing but if the images are not right the end result
will not be right. I �nd it works best to angle the torch away from the camera to avoid �are, and
to make sure some of the front of the stem is illuminated. The Adaptalux lights are not cheap,
there are similar lights on arms on Amazon, and another option is two mini tripods and two
torches.
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 Note that the top of the shrooms are often blown out or over exposed which doesn't
matter, it is just the underside of the shrooms we need when illuminating them because
they will be blended together. Also the ground will be illuminated by light spilling over which
again you can ignore, in post when combining images you can easily remove it, or sometimes
gently blend in a little to give the effect of light hitting the ground from the shrooms
themselves.

→ TIP

Illuminating one shroom at a time.
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An Autumnal Shaggy Parasol glowing in a dark wood.

Some shrooms especially larger species like these Olive Shaggy Parasols are quite dense and
are harder to illuminate from above because they don't transmit light quite as well. Light
transmits better when they are full of moisture but in dry conditions the �esh is quite dense and
it becomes harder. The two images below show how the light did pass through and the �nal
image had the torch positioned centrally so light transmitted evenly.

Illuminating a larger dense shroom from above.

ILLUMINATING DENSE SHROOMS
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If it is too dense the second image shows an alternative method by bouncing light up into the
underside. Shining a light directly into the shroom can work if you are very careful, use lower
power and avoid hot spots, and also avoid shadows. A shadow of the stem casting onto the
opposite side from the light source is a dead giveaway and looks terrible so try to keep the light
fairly even, for this reason a panel light never works, it's better to use a softer narrower beam
light. 

Also moving the light and taking two or three images to make the light more evenly
distributed, and then blending them together can work. If you take a number of images
moving the light source you will �nd it easier narrowing the aperture for depth of �eld from
front to back and shooting it as one image instead of focus bracketing, then merging them to
make the light more consistent. When processing I usually try to make the light a little brighter
in the centre by using masks and levels adjustments.
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SHOOTING TECHNIQUE

The camera technique for shooting the images is actually quite straight forward once you have
decided on the subject, composition and lighting.

IMAGE SETS

The diagram shows a typical shooting work�ow. The sets of images needed will depend on your
subject and the number of images you need illuminated. First one set of images are needed
that will be Focus Bracketed, or a Standard set. This is the main image and the one that the
illuminated set(s) of images will be merged into. 
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STANDARD NON ILLUMINATED 

3. ONE SHOT ILLUMINATED

ILLUMINATED SET 

The �rst set of images are you main set, taken in Raw and at f2.8 and Focus Stacked with your
Macro lens. These form the basis for your image.

The second set of images are your illuminated images used to blend into the �rst set. How
many sets will depend on your scene and subject and it will dictate how you decide to shoot
them. For instance if your image is one shroom and you are illuminating it just once, shooting
this set of images with the same settings means you are not disturbing the camera, and there is
a far better chance of them aligning successfully and blending.

Then a set of illuminated images will be needed, and there may be one, two or even three sets.
There are two techniques for shooting the illuminated images, either as a set of focus bracketed
images, or as one image with a narrower aperture for greater depth of �eld and there are pros
and cons to each.

1. STANDARD NON ILLUMINATED

Taken in Raw and Focus Bracketed. 
Number of frames depends on depth front to
back of subject, and distance to subject.

Taken wide open at f2.8 for foreground blur
and background bokeh.

2. ILLUMINATED SET

Taken in Raw and Focus Bracketed.

Number of frames the same as the �rst set at
f2.8 and under-exposed slightly. 

PRO: Very little disturbance to the camera.
Number of sets will depend on how many you
want to illuminate and equipment you have. 
CON: Number of images can build up quickly
and more stacking required.

Taken in Raw as one shot with narrow aperture. One frame with greater depth of �eld. Aperture
depends on sensor, perhaps f9-f14. 

PRO: Only one shot, less images to deal with and helpful when illuminating one scene multiple
times. 
CON: More risk of disturbing the camera and more work aligning images.



24

You will need to under-expose a little, but you're not going into menus and altering the focus
bracketing settings. If you have two shrooms illuminated you may use two light sources at once
to cut down on the work, or just accept additional sets are needed, illuminate each one one at a
time and shoot the sets. It does mean more images to deal with but it is usually more
successful.

Another approach is to shoot the illuminated image as one with a smaller aperture for great
depth of �eld. Your camera sensor, distance to the subject and size of the subject will dictate the
aperture needed, it may be in the region of f9 or above. This can be easier, especially if you have
to illuminate a few shrooms individually, although there are risks.

1 Set camera to Manual Mode. Set Aperture and Shutter

2 Set Focus to Manual with Peaking enabled

3 Refine Composition

4 Set Focus Bracketing (Test number of shots needed)

5 Take 1st set of non illuminated shots. Review and check

6 Take sets of illuminated shots as required

THE BASIC STEPS

ONE SHOT ILLUMINATED 

There is more chance of disturbing the camera because you're altering focus bracketing
settings and aperture, and the size of the subject will be different. As focus points move and
depth changes, so too does the size of the subject, it may be small but it can lead to alignment
issues, ghost edges and more work. I show how to deal with this in the processing tutorial.

What you absolutely shouldn't do is try to shortcut the number of images with one high depth
of �eld image for the subject at a narrow aperture, another for the illumination, and one for the
background taken wide open for background bokeh. It's more trouble trying to align and blend
than it is worth.
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This is possibly the hardest part of the shooting process because there are no pre-determined
number of shots or focus offsets (the number of steps between) we can use, and it will be
different for different lenses too. You will gain more knowledge through experience, and you
can set up a simple test shot at home using any small object to get a feel for the process and
number of images.

Focus Offset or Steps, (it may be called something different in your camera) determines how
much the focus shifts between shots, and the number of images determines how much depth
you have in the image. The number depends mainly on the size of the subject, and distance to
it. Experimentation here is important, and remember that having too many images is �ne, you
can delete unwanted images, what you have to avoid is having too few. 

Obviously you need a camera that has a focus bracketing feature. Once a few parameters are
set the camera will automatically move the focus point by a set number of steps to give good
depth of �eld as needed, and still keep the background and foreground out of focus as we
want. 

I would start off with a Step setting of 1 or 2, and then determine how many images are needed,
it may be 10, 20 or even 30 images. You'll need to review them and zoom in to preview, checking
sharpness and that you've covered the subject from front to back, which means disturbing the
camera. be careful but don't worry too much at this stage, these are the test shots to determine
step size and how many are needed. 

FOCUS BRACKETING

Once you've identi�ed how many are needed you can reshoot them, knowing you will not
disturb the camera.
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Composition is key so work on it until you �nd a composition you are happy with. These two
shrooms were growing on a dead tree trunk covered in dead ivy which I had to clear away, but I
was not happy with the bottom of the image. Using a little soil around the bottom meant I
could gently nudge them a little closer together and hide a piece of rotting wood. I also place a
few leaves in the foreground to soften it for the �nal image. 

The background here doesn't look too impressive until you understand what a few points of
light can look like through the lens wide open.

What I am really looking for is interesting bokeh in the background. A few highlights will give
really wonderful results so experiment with the position of the camera, move around with it
hand held to start off until you determine the best angle. Once you have, tripod mount the
camera and lock it all down as solid as possible. 

I prefer to shoot the images when the sun is a little lower in the sky rather than mid day when it
is higher so that I can get better highlights in the background. A �at grey day can also work if
you can get some bokeh in the background, and of course you don't always need highlights, a
soft subtle background can work too.

COMPOSITION
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A way to soften parts of an image is to hand hold a fern leaf in front of the lens, experimenting
with the position can really soften parts of the frame, or add a bit of a silhouette to a
background.

Many cameras have phone apps that will share the screen (Olympus has I.O. Share) but not all
will. If your camera has a video out port as most do these days a simple solution is to use a video
card, an HDMI cable and an Android mobile phone.

USE A TRIPOD

Make sure the camera is stable with a tripod (see the 'Gear' Section. If not you will struggle to
get anything to align properly. For this image I inverted the tripod column so it was actually on
the forest �oor but it was solid. 

It can be tricky viewing the screen at such low angles, most times I manage to get a
composition that will allow me to angle the screen so I can at least see it without being on my
belly. In this case the tripod blocked my screen and there was little I could do about it. 

VIEWING THE SCREEN
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A few notes, The big down side is it only works with Android. Apple block video-in signals to
iPhones and there is absolutely no way around it. I use an iPhone so I bought a second hand
Android mobile phone just for this. 

The mobile screen view is viewing only, you cannot change any settings, but it is still very useful
to compose you image, especially when at a low angle, and when trying to arrange your lights. If
you illuminate the shrooms and can't see the screen you're in trouble. Using your mobile as a
screen means you can set lights up on a Gorillapod with clamps and view how it looks. 

The Video card I use is a cheap and compact in-line card I found on Amazon for around £20. It's
small and basic but does all I need. Check the ports on your camera and get the right cable, it
will be male HDMI one end but different on the camera end. I also had a USB to USB-C adapter
to connect to the phone. You'll also need an app on the phone called 'USB Camera Pro'. 

Additionally some camera functions may be disabled. Using my Olympus OM-1 Focus
Bracketing is disabled as it is using IO Share also, but it is much faster just to plug/unplug the
phone than connecting/reconnecting IO Share. On my Nikon Z7 Focus Shift still works. It is
worth looking into especially if you have an Android mobile or you get get one reasonably
cheaply.
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Shoot at f2.8 and make sure the exposure
meter is correct by altering the shutter speed.
Be aware of the shutter speed too, you do not
want a shutter speed that is too slow, for one
shooting the sets of images at 1 second
shutter speed is going to take 20, 30 seconds
to complete the set depending how many
frames there are, and secondly there's a high
risk of movement with some of the smaller
shrooms which can move in just a slight
breeze. 

APERTURE AND SHUTTER SPEED

This is one reason why it's better to shoot in
daylight and then edit the images darker to
look like twilight. There isn't a correct shutter
speed, just be aware of consequences if it
starts getting slow.

There is also the possibility of light changing and affecting the exposures. For the �rst set of
images don't under-expose. I often darken the �nal image for more atmosphere but it is always
better to start with a good exposure and dark it to suit rather than a dark image and then have
to brighten areas which generates more noise. Do be careful with highlights especially in the
background. If they seem to bright and in danger of blowing you can always take one extra shot
with Focus Bracketing off to blend the areas you need in later.

It is best to set the camera to Manual. You can use Aperture Priority equally well and with many
cameras using Exposure Compensation is easy to do just by turning one of the control wheels.
Some cameras require an Exposure Compensation button to be pressed �rst, and the less you
need to adjust the better, there is a danger the more you have to press the more chance there
is of disturbing the camera. 

Be aware of wind, if it is a windy day you're unlikely to be able to shoot small shrooms unless
they are very sheltered. Shutter speed will depend on the subject size, weather conditions etc,
and you can always compensate by using a higher ISO, being aware it means more noise. I
would start thinking about increasing ISO if my shutter speed gets lower than 1/25th. It doesn't
mean you must use shutter speeds in the hundredths of seconds though. 

SHOOT IN MANUAL MODE
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And remember bugs, many times I've been photobombed by a bug and have been lucky
enough to have one or two of the frames with the bug sharp enough to include in the image
because my shutter speed was reasonable.

I normally auto focus for most of my work, so I will auto-focus on the edge just to quickly set it,
then switch to manual focus to check it and �ne tune. Many cameras have a 'magni�cation'
function when manual focusing so make sure it is enabled. Your Macro lens may have a focus
limiter switch. If it does they are useful to use for limiting the range the lens will focus usually for
a small distance for macro, or up to in�nity. Macro lenses can 'hunt' in auto-focus when it cannot
�nd the area to focus on so it hunts over the full range. Limit it �rst to stop this if you auto focus
to start off. If light is low as it invariably is use your torch on a low power to illuminate the
shrooms to focus.

Focus on the closest point of the subject to you, whichever point that may be. It will be the
closest part of the shroom cap. Your camera will have Focus Peaking (pixels along high contrast
edges are highlighted when in focus) which is invaluable when manually focusing, make sure it
is set in the menu and select the best colour for you if there is an option (blue, yellow and red
are the most common but I prefer white). 

 SEPARATE SETS OF IMAGES
You'll end up with quite a few sets of images and it can be hard to identify the sets when
you've imported them. At the end of each set put your hand in front of the lens to act as a
'marker' and take another shot. Be careful switching Focus Bracketing off not to disturb the
camera. Sometimes I don't switch if off, wasted images but easy to to delete.

→ TIP

MANUAL FOCUS

Take your test shots. Set Focus Bracketing on, set the differential or the steps between each
shot, and set the number of shots. As I said there is no �xed number so you will be guessing. A
small shroom 1cm diameter you may need 10-20 shots at a step of 1 depending how close you
are, a larger shroom you may need more shots, or a larger shroom you may be able to increase
the step to 2. 

TAKE YOUR TEST SHOTS

Take a test set, review and see if you have enough images to cover the depth of focus from front
to back. Remember to use a cable release. A wireless one can be handy, or just use a simple
wired one. Just don't use the shutter button.
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You've set everything up, composed the image, focussed it, taken test shots to identify how my
frames you need and the steps between them and you have everything locked down. Now do it
again after changing the number of frames if needed.. You have been making quite a few
changes to the Focus Bracketing and may have disturbed the camera, so as a precaution
double check your focus point and shoot the set again just to be sure.

Illuminating the �rst shroom.

ILLUMINATE AND REPEAT

Next, illuminate the shrooms and repeat the
process. Check how the illumination looks on
the camera screen, no easy feat sometimes.
Vary the angle, distance and power until it
looks evenly illuminated and try to avoid any
blown out areas. Blown highlights on the top
will not matter because it will be merged
with the �rst shots. I �nd it works best to
angle the torch away from the camera to
avoid �are, and to make sure some of the
front of the stem is illuminated. 

You will want to be able to see the screen
because now you will under-expose the
image to take account of the brightness of
the light. Alter the shutter speed to under
expose as much as needed. Using an external
screen as shown above might help, as will
using an additional tripod and clamps to hold
the torch. Arms never seem to be quite long
enough.

SHOOT THE 'KEEPERS'
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As long as you are aware of what can happen it is another way to shoot the images, although I
would recommend just shooting another focussed stacked set.

We have taken all the images needed, all Focus Bracketed. An illuminated set is also captured,
again focus bracketed, and additional sets taken as required. You can try this step as one if you
prefer. The next step is to process and merge them into a �nished image.

ILLUMINATE AND REPEAT...AGAIN

AND THAT'S IT

Do the same again for the next shroom.
Illuminate it, and shoot another set of
images. 

I shot another set that were focus stacked so
that I didn't have to change any settings, only
the shutter speed if some under exposure is
needed. As I already under-exposed the �rst
illuminated set I didn't need to change
anything, so I can just set the light and press
the shutter. 

There is another way that can be faster if you
are going to need quite a few sets of images. I
took another image with the aperture set to
f9 which gave me just enough depth of �eld
for this shroom front to back and used that
for the processing. The advantage is less shots
to deal with, the disadvantage is you are
handing the camera more, risking moving it,
and there will be more work aligning them. 
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PROCESSING TECHNIQUE

Inspecting the images, sorting them, stacking the focus bracketed images into sets, �xing
issues, then merging and blending into one �nal image.

IMAGE SETS

We explored how to shoot the sets of images required, now we need to process the shots and
stack them together, then merge the images produced into one �nal image. We will use this
image above for the tutorial which were taken speci�cally for this. 
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On1 One does have layers, it will focus stack images and also has masking for blending layered
images together. Not being an expert with it I found it not quite as easy or �exible to use, but it
may be worth a look if you want to avoid the Adobe eco-system.

Af�nity is probably the best alternative to Photoshop available right now. It will process Raws,
focus stack images and also has layers with plenty of tools for masking and blending. I would
personally use it along with a Raw processor such as DXO for all my Raw work and sorting
images, using Af�nity just for the power of stacking and layering images. 

For this step-by-step guide I will be using Lightroom and Photoshop. Lightroom as you
probably know is a 'Raw Image Processor' and Photoshop is an 'Image Editor', and the
differences are important. As a Raw Processor LR has more �exibility for processing raw �les and
importantly a Catalogue for sorting, rating, managing and synchronising processing settings. 

HELICON 

A �rst standard set of focus bracketed images were captured, along with a second set that were
then illuminated by hand using a torch. As another shroom is also illuminated, another image
was taken but instead of focus stacking it was taken in one shot with a smaller aperture to show
both techniques of shooting the illuminated sets. Both ways have advantages and
disadvantages, being aware of both techniques will allow more �exibility when out shooting. It
also allows me to show what to do the you run into problems such as the things don't quite
align.

SOFTWARE

Photoshop, whilst it can process Raw �les using Camera Raw doesn't have a Catalogue so it is
less �exible for batch processing many �les. What it can do which LR cannot is Focus Stack
images, and importantly, allow images to be layered and blended with masks. In truth there are
other options if you haven't subscribed to Adobe, all you need is a way to focus stack images,
and a way to blend images as layers.

AFFINITY PHOTO

ON1 PHOTO RAW 2022 

Helicon is a dedicated App for stacking focus bracketed images. It is easy to use and is probably
one of the best available. It has great tools for �xing issue too. You would still need another App
for layering and blending different sets of stacked images together. 
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 USING OTHER SOFTWARE
If you are not using Lightroom and Photoshop I would highly recommend Af�nity Photo. It is
fully featured and at just under £50 it is very good value. Although all the steps below are for
LR and PS you can still produce the same with a very similar Work�ow. In Af�nity you would
use Focus Merge, select all the images to open which opens them in a stack of focus merged
images. Af�nity has a slightly different way of �xing issues using the Clone tool and it is very
easy to do. Images can be layered and masks can be used to blend parts of images together,
in a remarkably similar way to Photoshop (even the mask icon is the same). You will need to
export your Raw image sets �rst from your Raw processor unless it has the facility to export
direct to Af�nity, whereas in LR we can simply select the images and send them to PS as Edit
in Photoshop As Layers. The main point here is don't be put off using other software, you can
still follow the steps below and apply the same work�ow. There are some great tutorials
available, check out these two on Af�nity's website which are very relevant, 
and using .

→ TIP

FOCUS MERGING
MASK LAYERS

Download your images from your memory card to a folder you've set up and named on your
hard drive. I tend to add subfolders to this folder so I can start to separate sets of images if I have
quite a few, but do this from within Lightroom. Once images are imported to LR never move
them externally or LR will lose the path (location) to them.

PROCESSING

STEP 1 - ORGANISE IMAGES

Standard Image Set Illuminated Image Set

Start to review images checking which are suitable to be stacked into a Focus Stacked Set. Here
I organised both the standard non-illuminated image set and the illuminated image set. I
actually had two sets illuminated, but we will get that step. Check they are in focus and that the
depth of focus extended from the front to the back of the subject across the set and remove any
that extend too far back. 

For this set I shot 30 images with a step of 1, as it turned out I only needed 21. From 21 to 30 the
subject became out of focus so ensure you remove these or Photoshop will create 'ghosting' or a
halo which looks like a double image. 

https://affinity.serif.com/en-gb/tutorials/photo/desktop/video/295557891/
https://affinity.serif.com/en-gb/tutorials/photo/desktop/video/332168517/
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Now we will create the �rst Focus Stacked image from the �rst set of images. Make sure you
have Photoshop open in another window �rst for ease of use.

STEP 2 - STACK FIRST SET

 You may want to save this new Photoshop File on your hard drive for future reference. Make
sure you save it as a Photoshop PSD so that you can open it again with all layers and masks
preserved. Note there is a limit of 2GB, larger �les may need to be saved as a PSB instead.

→ TIP

Focus Breathing is created by the size of the subject actually changing in the frame as the focal
plane moves when the focus point changes. . Normally it isn't an issue, but have the bracketing
steps too wide, or have too many redundant images where the focus is too far forwards or
backwards and parts of the image can be merged creating the 'halo'. 

Open As Layers...

Sort the images by simply adding a colour rating, hit 6 on your keyboard to use yellow, applying
to the �rst and the last image in each set to separate them from images not needed. You may
even �nd it easier to create new folders or even Collections. 

Apply any processing you may want but there is no need to do too much at this stage. You may
want to make adjustments to exposure, shadows and highlights and white balance. On the
illuminated set I had over exposed the right edge a little so I recovered it and then synchronised
it across the image set. Then select the �rst image, press Shift and select the last image, then
click Sync on the bottom right. The colour coding and adjustments will be synchronised across
all the images.

Select the �rst set of duplicated images again.
Select the �rst image, click and hold Alt and
then click the last image to select the
complete set. 

Right click and in the menu which appears
select .
Wait a few moments and Lightroom will
export each image to PS, adding them as
layers in one new document.

Edit In > Open As Layers in Photoshop
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In the Layers pallet on the right select all the
images by clicking the �rst layer, hold down

 and select the last image. Shift

Then  (do not release), and drag
the whole set of images over the Plus+ icon at
the bottom which will create copies of the
images. 

click and hold

Now if you wish you can add the images to a group for easier management. With the images
still selected click on the shortcut menu icon (three horizontal lines next to the word 'Layers'). Go
down the list and click New Group from Layers. A dialogue will appear allowing you to give the
group a name. 'Copy' is as good a name as any. Click ok, and now you can show or hide the
whole set by clicking the eye next to the Group.

 A note on Layers and other Pallets. Pallets are simply dialogue boxes housed or 'docked' into
the right hand column. If you don't see 'Layers' go to the top menu bar, 'Window', click 'Layers' to
make it visible, then click and hold the tab to drag and position anywhere you want in the Dock.
You absolutely need to have Layers and History visible.

→ TIP

Before going to the next step we need to copy the images and preserve the originals just in case
they are needed later.

Duplicate the Layers

Next we need to merge all the images into one focus stacked image. Before this they need to
be aligned in Photoshop.

Auto-Align Layers

STEP 3 - ALIGN & FOCUS STACK

Select the �rst set of duplicated images again
in the layers pallet. Select the �rst image, 

 and then click the last image to
select the complete set. 

click
and hold Alt

Go to the top menu Bar and select 
. A dialogue box will open,

select . Vignette Removal and Geometric
Distortion can be ignored.

Edit >
Auto-Align Layers

Auto
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Now we need to blend the images into a focus stacked image. Select the �rst set of duplicated
images again (if not still selected) in the layers pallet. Select the �rst image, 
and then click the last image to select the complete set.

click and hold Alt

Auto-Blend Layers

On the top menu bar go to 
. A dialogue box will open, select 

 and enable Seamless Tones and
Colours and Content Aware Fill Transparent
Areas. 

Edit > Auto-Blend
Layers Stack
Images

Content aware �ll will �ll the edges of the
image so that none of the canvas (the
document background) will be visible. 

Image Text

Once the process is �nished if any �lled areas are selected and visible with 'marching ants' as
they are known, or dotted lines, just deselect them with Select > Deselect (Option+D keyboard).

Now notice in the layers Pallet each of the images has a mask applied and the top image will
have a name appended (merged). PS has analysed each layer deciding which parts of the
image are in focus and applied masks to each. An important detail to understand with masks,
white will 'reveal' and black will 'hide' parts of the image. 

So in each layer parts of the image have been hidden with black to only show the white areas,
or the parts in focus. Each of these will show into the layer above it and the set has been made
into a new merged image (or a composite if you like) as the top image. I've switched the
visibility off ready for the next step. 
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The �rst step is to ensure that the detail was actually there. On the layer images this may be
dif�cult because masks have been applied which may be hiding the detail so switch off visibility
of the entire set using the 'eye' next to the folder icon on the whole group. 

I'm going to assume you are unfamiliar with PS and have never used the Paint Brush, we need
to set some properties for it. If you are familiar you can skip this bit.

STEP 4 - RECOVERING DETAIL

PHOTOSHOP PAINT BRUSH

Photoshop does a great job but it doesn't always get it right. For some reason the left hand
edge of the shroom on the left is not in focus but the detail was there so we need to recover it.

You will see the original images (which we duplicated) as layers underneath, and you can switch
them off individually to �nd the right image. Alternatively and usually faster, just go back to
Lightroom and go though the images until you �nd the right one and note the image �le
number. In LR I found that it was actually the fourth and �fth images that had the edge in
focus, noting the image names I can easily �nd them in the layers. 

Tools in PS are available in the Toolbar on the left hand side of the screen. Many tools are
stacked meaning they may be hidden, any tool that has a small triangle on the bottom corner
means there are more stacked in that set. Click and hold and they will �y out. The Paint Brush is
the 11th from the top, if you see a Paint Bucket instead just click/hold and select the Paint Brush.

All we need to do is paint the detail back in. Make sure they are visible again if you switched
them off, and hide the top merged image by switching the visibility off. We will use the Paint
Brush to bring the detail back, just follow the steps below.

Paint Brush Tool Paint Brush Colour
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At the bottom you'll see the paint colour, two squares with black and white and a double
headed arrow. The arrow can be clicked to swap the colour, so click it and set the colour to
white.

PS Brush Properties

Now at the top notice the has changed. It is context sensitive and will change
depending on the tool selected. It has updated to show  for the Paint Brush. Now click
the 3rd icon along to reveal the properties. Select a soft round brush, set hardness to 0%
meaning it will have a soft edge, and opacity to 30-40%. 

Tool Bar 
Properties

SET THE LAYERS

Opacity and Flow sets how much paint is laid down and how visible it is. I tend to ignore �ow
and use opacity to control how much paint is used. Ignore size for now because it can be set
using the keyboard bracket [ ] keys. Now you'll see your cursor is a round circle allowing you to
paint, and each stroke you make can be undone if you make an error by clicking back a step on
the .History Pallet

Now set the layers ready to start recovering detail. Important, we need to ensure in each step
that the Layer Masks are active by clicking them (as shown below) and not the image. If the
image thumbnail is active you will be painting onto the image itself, not the mask. If you make
an error just undo it in the History Pallet.



41

Add a white mask to the top Layer

Now start painting. Go back to the layer you identi�ed as having the 'in-focus detail' (there may
be more than one), click  not the image thumbnail, then on the
main image in the main window (not the Layers Pallet) start painting over the area where you
need detail recovering. 
Adjust the Brush size with the [ ] Bracket keys on your keyboard and adjust the opacity to suit.
You will see detail start to magically reappear. 
When performing tasks like this it's always best to use small strokes so if you make an error you
can click back in the History Pallet to undo it. And remember white reveals, black hides, so if you
need to, swap paint to black and repaint to re-hide an area again.

on the mask layer to activate it,

In the Layers Pallet click the top merged
image thumbnail and add a white mask to it.
The is handily placed at the bottom
and is a white rectangle with a circle, next to

. Then click the eye icon to hide visibility of
the top layer. 

Mask Tool 

FX

Remember this is the composite or merged
image of all the others under it, it needs to be
invisible so we can see changes made on the
images under it.

Now switch the top layer back on again by
clicking the eye icon to reactivate the layer
visibility. Notice what happens? The details
we recovered vanishes again. This is because
the top layer is the merged composite of all
the images under it, we changed the images
under it but they cannot re�ect in the top
image. Rather than the long process of
copying all the images and making a new
merged image there is a simple way to �x
this.

We already added a white mask, so click it to
activate it, then back on the main image
window just paint over the areas you just did
again, but with black paint.

Painting on the TOP Layer Mask
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 Notice the keyboard shortcuts that are displayed on menu items which are very handy
to learn. There is also a shortcut menu on the History Pallet at the bottom. There is a New
Document icon for creating duplicate of the whole document, New Snapshot icon which will
create a snapshot of the current history state, and a Trashcan Icon.

→ TIP

We want to show the changes we made on the layers underneath, white reveals and black
hides. The white mask is showing all of the top image so black paint will hide part of it. This time
the same amount of care is not needed, increase the size of the brush and increase opacity and
quickly paint over the area. Notice I also painted over the stem because there was a little detail
on one of the masks I also recovered. (You could also stamp the layers into a new layer but I
don't want to further complicate it).

That's the �rst set of images complete, hopefully you managed with this easily enough although
if you are completely new to PS it can be daunting.

There are a few decisions to make now. I would normally just �atten this set of images into one
layer ready for the next set, but what if you want to save it for future reference? If you do want
to save this step go to the top Menu Bar . Give it a name that will make sense
(eg 'Shrooms First Set'), make sure  is selected to preserve them, decide where to save it
and save as a Photoshop document. If you don't want to save this step with the layers for
reference later (I never do) just �atten it and move on to the next step.

File > Save a Copy
Layers

It is going to get quite large with all the layers and we will be moving onto the next step so I
normally just �atten this document into one layer. On the top Menu Bar go to 

. Your document is now one layer. For this tutorial I have left most of the layers intact. We
can now move onto the illuminated set of images.

Layer > Flatten
Image

SAVING YOUR PROGRESS

FLATTEN YOUR DOCUMENT
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Rinse and Repeat. Yes, start all over with the illuminate images. 

STEP 5 - ILLUMINATED SET

Now you have done it once you should be able to go through this step fairly quickly. Again in
Lightroom sort the images, send them to Photoshop as a layered stack of images, duplicate the
set,  them,  them, and you will end up with another document consisting
of layered images with masks applied and a top image which has been merged from the full
set. 

Auto-Align Auto-Blend

The advantage of doing another set of focus bracketed images is you have not touched the
camera at all so there is little chance of the images not aligning. The disadvantage is obviously
the number of images you will have and having to go through the alignment and auto
blending again, but it is pretty quick when you've done it a few times. 

Illuminated set after Auto Alignment and Auto-Blending

Again save this step as a new document if you want to save for future reference 
 or if you're happy with it just �atten it into one.

(File > Save a
Copy)

Notice in this set the right hand shroom has some illumination which is from the overspill light
on the left shroom. I'm not interested in this because I did another image for it which we will
get to. 

Remember to check if any details need to be recovered, but all we are concerned about is the
stem and the underside of the shroom. 
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Now we have two images, one standard non-illuminated set which has been focus stacked into
one image, and the same again for an illuminated set, which we can start to merge into one
document and one image. We need both images from each set layering into one document
with the illuminated image on the top. There is a very simply way to do this which is very fast as
shown below.

Dragging one layer from one document into another

Both your �les will be open and you'll notice they have their own tabs at the top in the
document window as shown. Click on the illuminated shroom image tab, then holding down on
it drag it out so that it is a '�oating' window over the other image. Make sure you can still see the
other image underneath. 

STEP 6 - BLENDING THE TWO IMAGES

Now click the top �oating image to make sure it is the active window, click its thumbnail in the
, then click/hold and at the same time , then drag the layer over the

image behind it and release. Pressing/holding Shift tells PS to register the layer in the same
place so they will be aligned, otherwise the layer will be positioned wherever you 'drop' it. 

Layers Pallet press/hold Shift

This does seem to take some people a few attempts but its easy and you'll be surprised just
often you use this going forward to take one layer out of a document into another without
having to mess around saving and importing. 
Another way is to click the layer (double click if it is locked), then  and then 

 into the other document. 
Note if you do it this way the image will be pasted above the layer you have 'active', so if it ends
up below other layers it's probably because you didn't have the top layer active (click it to
activate it). 

File> Copy, File >
Copy and Paste > Paste In Place
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 When you have a �oating window and click the main PS window to make it the active
document, the �oating window will disappear. It hasn't, it's simply hidden behind the other
windows. Just go to the top menu Window > Scroll down to the bottom list of open
documents and click to bring it forward again. I use a Mac trackpad and just swipe up with
four �ngers to reveal them.

→ TIP

There are now two images layered over each other, the non-illuminated image and the
illuminated image. All we have to do now is apply a mask and then use the Paint Brush to start
showing the illuminated layer into �rst image, but there are a number of ways to do it.

BLENDING

Activate the illuminated shroom image layer by clicking it, then  and click the
Mask tool underneath. Alt tells PS to �ll the mask with black, thus hiding the image. Remember
black hides, white reveals. 

press/hold ALT

Make sure they align properly. In the Layers Pallet switch the top layer off and on to check it. If it
needs slight adjustment you can alter the opacity of the layer and use the Move tool (four
direction arrow icon on the Tool Pallet) to adjust it. Use the keyboard arrow keys for very small
adjustment.

METHOD 1 
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Then with the Paint Brush with a soft brush, low opacity and small brush brush size start
painting over the shroom (on the main image) to reveal the illumination back into view. Make
sure the mask layer is active, not the image layer or you will be painting on the actual image
layer and not the mask.

METHOD 2 

How good were you at colouring in between
the lines? This method is a little more
involved but gives much more control. 
Before adding a mask select the 

 in the  (a brush icon with
dotted circle). 
Notice the menu bar changes again to show
properties for this tool with 

and 
 The size of the tool can also be

altered with the Bracket [ ] keys.

Selection
Tool Tool Pallet

New Selection,
Add To, Subtract From, General
Properties.

Modifying Selections in PS

Set Hardness to 100%, Spacing 25%, then alter the size to quite small and start clicking on the
image on the illuminated parts. You'll see the area being selected and the area shown with
'marching ants'. 
Use the  and  if needed, but an image like this should be very easy with just a
few clicks. 
Note under  there are further tools for re�ning selections by 

 them. 
For this image none of the re�nements were needed but it's worth noting because making
selections is one of the main skills to learn in PS.

Add Subtract From

Select > Modify Expanding,
Contracting and Feathering

Now click the Mask tool again at the bottom of the Layers Pallet and see what happens; the
selected area is �lled with white and the non-selected area is �lled with black, so the
illuminated area is now visible and the rest of the image is now hidden. Magic!
See the layer thumbnails in the image at the start of this section. Sometimes this is all that is
needed. 
You can now re�ne it a little by using the Paint Brush alternating between black and white,
altering the size and opacity and maybe feathering edges a little to blend in areas more, paying
attention to the stem to blend in seamlessly, and also the top of the shroom too. 
If you need to activate the selection again go to  to reactive the selection.Select > Reselect
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 Remember black hides and white reveals. You may want to work the other way
around to gently blend the illumination in. After making a selection for more control on the
illuminated areas, then adding a mask, the selection will be �lled white to show, with the
background black to hide. There's nothing to stop you using black to paint over the whole
mask, hiding it, then using white and slowly bringing the illumination back into the image,
working from the centre out towards the edges. Use Select > Reselect to reactivate the last
selection if you want to stay inside the edges. Sometimes this way works better if you want
light to glow out from the centre.

→ TIP

We are almost complete, so far you will have a standard non-illuminated image and an
illuminated image blended together, so congratulations.

One illuminated shroom blended in.

PROGRESS SO FAR

Check the image, make sure it is all good, and
if you are happy and have no need to make
any more adjustments save it. 

If you want to save the layers do as we did
before and Save A Copy for future reference.
If you are at a point where you are done, save
the image after �attening it as a Tiff or a
Jpeg. I usually save as both. 

We have a few more steps to do with this
image, �xing issues and  blending in a second
illuminated shroom.
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 Ever noticed how sometimes you can end up with an annoying white edge around
some elements after processing an image? Usually it's caused by being a little too aggressive
with contrast or recovering highlights. It's an easy �x, use the Clone Stamp Tool just as above,
but set the Mode to Darken, sample close to the edge and run the brush along the white line.
PS will then only �nd the bright line and replace it with the area sampled. And because it is
set to Darken you do not even have to be that careful, there is certainly no need to make any
selections. Neat!

→ TIP

I noticed on this image there is a slight issue on the bottom edge of the shroom, caused by the
two sets of images not quite aligning properly. It can happen and it is an easy �x using the

 which will sample the pixels of the background and replace the pixels of the
dark edge.
Clone Stamp Tool

The dark edge half cloned away

Now select the , which looks like a rubber stamp. The Menu Bar changes
again, set it to , and size quite small. Position the
cursor near the edge and press . It now turns to a target icon which is sampling the pixels
under it, click to sample the background but not the dark tones of the edge or the yellow. 
Now just  and start brushing over the edge and watch the dark line start to vanish.
Photoshop is replacing the dark pixels of the edge with the pixels we sampled. Notice a cross
hair which shows the area that is being sampled.

Clone Stamp Tool
0% Hardness, Mode: Normal, Opacity 60%

ALT

click/hold

FIXING ISSUES

First I use the  tool again, I
want an edge to protect the glowing part of
the shroom. Selecting the background area
didn't select the dark line, and as I want it
selecting, to save lots of messing about I just
quit it  then clicked over
the bright yellow area to select that instead. 

Quick Selection

(Select > Deselect)

The edge is much better with the yellow
selected, but as I want the background
selecting I can just use . The
selection is now reversed or swapped and the
dark edge is included. It's sometimes faster to
do this.

Select > Inverse

We are going to make a Selection of the area and clone the edge away. Making a Selection
gives us a border which will prevent anything we do going over the edge, so just like painting
inside the lines.
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Blending in another shroom really depends how it was taken. You may have used two lights
which means you can blend in the illuminated image as one set, or you may have taken
another focus stacked set of images. If so, just follow the steps above and go through the
process again. Save a copy of the document for future reference if you wish, then �atten it,
produce the next set of images and stack them, drag or copy into the main document as a new
layer and blend it again.

Another way is to shoot the additional image with a narrower aperture for depth of �eld,
perhaps f9-f14 depending on the lens and sensor, and not focus stack it. The advantage is
obviously less images to process and stack, and if you have a few shots to illuminate in one shot
it can be easier.

The disadvantage is by altering the aperture you are disturbing the camera and the images are
sure not to align. It can also be dif�cult to get them to align because by altering the depth of
�eld in one image you will effectively alter the overall size of the shroom, possibly not by a great
deal, but enough to make it more work to align. It can be done, and the next steps below will
show how. 

STEP 7 - BLENDING ANOTHER SHROOM

What will not work is taking an image at f2.8 for the out of focus background and the wonderful
bokeh, then shooting the main standard set and the illuminated set at a smaller aperture for
the depth of �eld. The main set would have such soft edges around the shrooms because of
Focus Breathing and you will end up with halos which will be hard work to remove. Shoot your
�rst set focus stacked and then additional images at a smaller aperture if you prefer.

The second illuminated shroom as another layer in PS after cropping it.
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The single shot f9 image is opened in PS from LR after copying the same processing settings to
it. Once open in PS instead of loading the full image (dragging or copying), I cropped it �rst with
the crop tool. 
Because I will need to do some repositioning and some resizing I crop it, just retaining the main
subject and making it easier to see the selection handles (the small dots) around the edge. I
lower the opacity of the layer to allow me to see the edges underneath too.

Repositioning the layer as close as I can.

By clicking the layer I can then  and drag it into position. Using the  tool and the
keyboard arrows means I can �nely place it. 

click/hold Move

By  I can drag the selection handles on the outside the the image, and by
clicking one of the corners and holding I can also distort it. Using
all these tools means I can after some adjustments get the image matching up pretty close to
the image underneath.

clicking/holding
Command (Windows Control) 
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The second shroom now blended in.

Just as previous I made a selection of the shroom with the Quick Selection Tool and added a
mask, which �lls the shroom with white to show, and the background in black to hide.

Now only the illuminated area is visible and the background is hidden, removing the part of the
shroom on the left which was not matching up. 

Another adjustment is needed because there is a double edge on the bottom. Selecting the
layer again with the Move tool to show the handles, I can click on the lower centre handle,
press/hold Shift and move it up which alters the height but not the width, in other words
compresses it. 

Thankfully we are almost done. As before save a copy of the document if you wish with the
layers, and then �atten it. Next I saved the image because I want it back in LR. Do note if you
have renamed the �le you cannot save it back to Lightroom, which can be annoying. 

Finally I can use the brush tool just as before to blend in and re�ne some edges.

STEP 8 - FINAL STAGES

If you want the image in LR again for some further work you can save it and import it, or a little
trick that saves a whole lot of time, open one of the images from the set in LR into PS (select
image, right click and ), then drag the shroom document layer onto the image
you just opened as before and save, it will then appear in LR. 
It will be brought back in as a Tiff if you have set Tiff in LR, (

 which can bloat your catalogue. Once I'm done with
these I delete them from Lightroom because my �nal image is saved from PS with a
meaningful title, so I don't need to keep them.

Edit in Photoshop

LR > Preferences > External Editing >
Edit in Photoshop > File Format > Tiff)
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In LR I will do my last edits which are more creative, I may alter the white balanced tint into
blue to make it look more like twilight, alter tones and contrast a little, and use masks to alter
the image. Note you could do your �nal edits in PS, or whichever App you are using

The blended image back in LR for some �nal edits. Here, adding a Radial Grad for a Vignette.

Here in the Mask section I've used a Radial Grad, then clicking on the icon in the dialogue I
reverse it. I can then alter exposure to act as a vignette, and doing it this way means I have
much more control over size and positions. 

The very last step and one I always do is to open it again in PS, and apply noise and sharpening.
I use Topaz DeNoise as a plugin in PS. I copy the layer, run Denoise, and then if needed I can
apply a mask and paint anything back in if Denoise has removed any detail. I then Save the �nal
image with a meaningful title to my Hard Drive.
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Below is the �nal image after making some adjustments in LR. I wanted the background a little
darker and altered the colour of the illumination a fraction, and all in all I'm very happy with the
result. 

The �nished image.

COMPLETE

Another thing to consider is when you are merging in the illuminated layers is to keep some of
the illumination on the ground as though the shrooms are illuminating it. It's easy to do by
using the masks and the paint brush. 

It may seem to be hard work with a lot of steps and there are, but once you have done it a few
times many of the steps are very quick and you will speed through them. 
The biggest challenge is to have a vision of what you want to achieve and try to stick to it, after
all producing a 'Glowing Shrooms' image is creative and you should try to be creative with it. 
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This image below is an example of one way to deal with multiple shrooms in one image where
lighting and stacking is going to get very complicated. As there are so many in one group it
would require a focus stacked standard set (non-illuminated) and then multiple sets depending
on which you want to illuminate, perhaps 2, 3 or even four sets, so it can quickly start to get
complicated. 

Various sets of focus stacked images.

ANOTHER EXAMPLE

One way as we saw in the processing steps is to shoot the illuminated set as one image with a
narrower aperture for more depth of �eld, but alignment will be an issue. Sections of the image
could be cropped and then aligned individually to get around trying to align one main shot. In
this case I decided I would illuminate it twice, thus have one non-illuminated set and two
illuminated sets. 

This meant I didn't have to change settings other than under-exposing the illuminated set a
little. Notice the depth of �eld is quite narrow and doesn't extend all the way back; this was a
conscious decision, having parts of an image out of focus can actually add more visual depth
and interest to an image.
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Three sets of shots were taken, the �rst non illuminated focus bracketed set which form the
main image. Another set were taken illuminating the main shroom and some in the rear, and
another set illuminating some of the smaller shrooms at the front. They are inspected, sorted
into colour coded sets, any processing is applied to the �rst image of each set and then
synchronised across each set ready to merge.

STEP 1 - THE SHOTS

Main set taken 60mm Macro f2.8 - ideal step
was Focus Offset 2

Illuminated sets with the same settings, under
exposed

STEP 2 - LAYER IN PHOTOSHOP

Images are selected and sent to Photoshop as layers, right click and go to 
. Duplicate the layers and group one set together.

Edit In >Open as
Layers in Photoshop
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Select the layers and align them just as previous  and select Auto.Edit>Auto Align Layers

Then Auto-Blend the layers so there is one 'merged' image  and select
Stack Images.

Edit>Auto Blend Layers

STEP 4 - AUTO BLEND

STEP 3 - AUTO ALIGN
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Send the illuminated set(s) to Photoshop, align and stack them, and �x any issues. In this screen
shot I have taken the two illuminated sets after Auto-Blending them, placed them into one
document and merged the illumination together. Notice the torch visible from two different
images which I need not be concerned about removing yet.

STEP 5 - RINSE & REPEAT

Next the illuminated set is dragged or copied onto the standard non illuminated set, a mask is
applied and I start to blend in the illumination, working on it until I am happy. Another little
trick, if you have part of the image that will not align, make a copy of it by dragging to the New
Layer icon, remove the mask (right click and delete it), then position it where needed and add a
new mask. From one image you can make copies and position different parts if needed.

STEP 6 - COMBINE ALL
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Once you are done with all the merging you can save it, take it back into Lightroom for further
work if needed and work on areas you feel could be improved such as darkening the
background a little or altering the colour tones.

Once you persevere with the processing aspect of producing 'Glowing Shrooms' you'll �nd you
can go through the steps quite quickly and with con�dence. It is technical, but once you are
comfortable with it you can then concentrate on the fun bit, getting creative with the �nal look.

CONCLUSION
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INSPIRATION

A small collection of images with descriptions to inspire and encourage your shrooming journey.
All images were taken with the Olympus 60mm Macro lens at f2.8, with the exception of 'Night
Light'. All were focus stacked with various step differentials and captured as illuminated and
non-illuminated sets, then blended in Photoshop.

EXTENDED FAMILY

The image I've used as the banner and one that did take quite a bit of work but it was not as
complicated as it may �rst appear. Firstly the composition is set ensuring I'm happy with how
the subject is placed in the frame and that there is suitable background bokeh. 
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Quite some patience was needed for this
image, and a lot of luck. A base set were
captured along with 3 sets illuminated. Each
shroom was illuminated with a thin pencil
torch and the sequence of images captured
without changing any settings. 

Although it does result in a lot of images and
not all will be needed, if your �rst set are
sharp front to back sometimes it is quicker
just to repeat the sequence rather than reset
the focus point and risk disturbing the
camera too much. Just as the �nal set was
complete a �y photo-bombed me. 

Without changing any settings I reshot the
whole sequence and luckily for me by just
retaining the 3 or 4 frames where the �y was
sharpest I produced another stacked imaged
and blended it into the other images as the
�nal step. It's worth looking out for bugs that
do sometimes appear, and be aware of your
shutter speed too.

THE FLY

For this image 2 sets were needed with a hand held torch, �rst a set with a torch held towards
the rear and another set held towards the front. After each set are stacked individually, the 3
resulting images were then stacked together and blended to bring light in just where I wanted
it. It does take some patience but the results are worth the effort.

A base set of focus bracketed images were taken at f2.8, and in this case notice the sharpness
doesn't extend all the way to the rear shroom, allowing for some out of focus blur will actually
add depth to the image, but make sure there will be enough separation between the subject
and the background. Next the illuminated images were taken. 

One thing to remember is the �rst set of images which will be the base set and includes the
background will change as the light changes. If the highlights are created by sunlight the sun
will move, so don't take too long. 
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TWILIGHT GLOW

What absolutely fascinates me with Glowing Shrooms is just
how creative it can be. This image was captured in daylight
and after experimenting with how the light passed through
this shroom I decided I wanted to capture with the outer rim
glowing almost as if it were illuminated by UV light. 

Getting the composition right was important, I needed to be
able to see the whole rim and have some background bokeh
just above it. Illumination was simple enough just with one
torch hand held. 

Creating the mood is achieved by �rstly altering the white
balance to a cool blue tone, synchronising it across all the
frames, and then working on the colour balance of the �nal
stacked and blended images to give a feeling of twilight to
the image.
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BUGS LIFE

I'd decided I again wanted a dark twilight
image to contrast with some warm light
radiating fro the shroom. Angling the camera
makes the large shroom (which was only
around 20mm diameter) lean into the centre
of the frame which I feel is more pleasing. 

The background bokeh gave some great
silhouetted de�nition to the shroom, and I felt
it needed a little more so I found another
smaller shroom and repositioned it so it was
silhouetted in the bottom circle of light.
During the shots a bug appeared again. It
was moving and the �nal images were quite
a mess so it had to be cloned right out, but
again selecting just one of the frames where
the bug is acceptably detailed I was able to
clone it back in again.

TWO SHROOMS

Two illuminated shrooms both illuminated
individually. This is the image used for the
processing tutorial which shows step by step
how they were processed and blended
together.
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BACKGROUND BLUR

Rather than shoot this set of three shrooms
with the focus extending from the front all
the way to the back I decided to keep just
the front one in focus. It was very much a
conscious decision because sometimes it
can add more depth to an image, leaving
part to the imagination.

Notice the shroom in the background, I
wanted to lift it a little so I made sure part
of the background bokeh was just behind
the cap. Being aware of the background
just as much as the shrooms really does
make a difference.
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LIGHTING THE WAY

NO ILLUMINATION

This image was a combination of the sets of
images needed for the shroom, one set
illuminated and another non illuminated,
plus another for the snail. 
I noticed the snail nearby so I placed him on
the log next to the shroom after I'd �nished
with the main shots. It was important to have
him in position so that he was on the correct
angle and would look natural when blended
in. 
It was of course a task because he refused to
go the directing I wanted, but a leaf and
some gentle coaxing and eventually he did,
even looking the direction I wanted. The snail
was much bigger in reality, it was reduced in
size to suit what I wanted. Some light was
painted in using a polygon selection and the
paint brush with very soft colour, and
highlights added to the snail. To look more
natural the highlights on the snail were given
a Gaussian Blur to give it a glow.
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Not all images need to be illuminated. The shrooms are leaning into the frame which is
balanced by a couple of fern leaves on the opposite side. Highlighting the shrooms by placing
the background bokeh behind them draws attention where it should be. Editing the tones into
a twilight blue gives the atmosphere I wanted despite it being a daytime shot. Shadows were
also given a tint towards blue and contrast was lowered.

These two shrooms were twisted together as though embracing and it was hard to resist not
getting an image. The delicate tones and the earthy browns of the leaves had to be consistent
through the image so the background was edited carefully to give a harmonious colour pallete. 

EMBRACE

Note the bug on top? It happened again, just as I was shooting the �rst set of images it popped
up. My shutter speed was only 1/30th second but it was enough to capture the little fella.
Obviously it isn't going to be still through the whole sequence, so �nding a couple of frames
where it is sharp is all that is needed. 

Once the �rst set is stacked there's ghosting because of the movement of the bug which
needed to be cloned away. Then the bug is blended back in just using the image(s) tat are in
focus. If there's more than one image with a bug that look acceptable stack them and then use
them to blend into the �nal image.
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EMBRACE 2

The same two shrooms as above but with a
different composition and slightly different
editing. These two were so cute I couldn't
resist another shot, and I wanted a different
feel to atmosphere too.

The colour was altered to give it a colder tone.
Notice that the light illuminating the shrooms
in both images is very subtle, it is illuminated
by hand but I wanted both images to appear
as though they are illuminated naturally by
the background bokeh.

SUNSET SHROOMS

I tend to only illuminate the shrooms from
above when possible, and only from below if it
is particularly dense. 

For this image I wanted a different
atmosphere with some warm side light
instead of illuminating the gills. I just used my
LED panel light, placing it to the side and
altering the temperature to warm. 

The background was edited to my taste and a
small branch with a few leaves was hand held
on the right to give a little more interest.
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SILHOUETTES

This small group of shrooms used illumination and
silhouettes. The foreground shroom is illuminated and
stacked leaving the background shroom dark and out of
focus for depth, and the angle of the camera was placed so
that it would be silhouetted against the background light.
Using boken and silhouettes can add another dimension
to you images and create more interest.
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Another very Autumnal colour palette, this shroom was around 4" (100mm) diameter. A �rst
non-illuminated set were taken focus stacked at f2.8 and the illuminated image taken as one
shot at f9.  The depth of �eld was a little shallow on the gills underneath, the rear is a little soft
but the stem is sharp. The main set of images at f2.8 leave the background and the rear shroom
out of focus which was a conscious decision, for me it adds more interest. 

NIGHT LIGHT

It was impossible to view the rear screen to see what I was doing when I illuminated them so I
used a video capture card and a mobile phone as an external monitor.
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My preference for atmosphere when producing Glowing Shrooms is for twilight, but when
there's some golden light when the sun is low it can be very attractive. This image was taken
late in the afternoon when the sun was low giving warmth to the background bokeh.

GOLDEN BOKEH
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The front of the top shroom is a little too bright and I had too much light spilling over onto the
tree trunk. Be careful how light spills when doing the illuminated shots. I could �x it because I
have the images to do it, I could easily blend in more of the non illuminate shroom and the tree
trunk. I tend not to go back and �x images afterwards though if it is some time before I realise
the mistakes, I just move on and learn from it.

Although Glowing Shroom images are quite a technical process with the amount of images
needed and then the processing, it is also surprising creative. Experimenting with the
illumination, background bokeh, silhouettes gives quite an amount of creative freedom, and
then the processing allows you to be imaginative with the �nal image and the mood you want
to create. Low sunlight, twilight, moonlight, all are possible with a little imagination. I do hope
this has been useful and I wish you every success with your images.

CONCLUSION

I've included this image as one I consider a fail, when at the time I was happy with it. The
composition is �ne, the background bokeh is simple and quite attractive but the lighting is
wrong. 

A FAIL
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OLYMPUS SETTINGS

This section deals with shooting Glowing Shrooms using Olympus cameras which is my main
camera, with some useful tips and tricks. Any camera that has the ability to focus bracket can be
used although Olympus cameras do have some features that are worth noting. If you are not
using an Olympus camera you may still �nd a few tips that could be useful. Adding Peaking to a
button for example is a great way to use show it without touching the focus ring.

OM-1 GUIDE

I wrote a Guide for the OM-1 which you will
�nd very useful if you use this camera. 

It's full of tips and tricks, with a full Menu
walkthrough, advice on settings, suggestions
for Customs Modes, and details for all of the
in-camera features such as Live Time, Live
Composite and others, with examples of how
to use them. 

It also covers all you need to know about
photography including composition,
exposure, depth of �eld, planning and
research and processing work�ow. 

More information is available .here

https://www.philnortonphotographyblog.co.uk/about-olympus-om1-guide
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Olympus cameras are fully featured and most support Focus Bracketing/Stacking. Not all lenses
support focus bracketing although the 60mm f2.8 Macro does, and this is the lens I suggest you
use, along with the 30mm Macro. Other lenses can be used such as the 12-40 f2.8 Pro if you
don't have a macro lens and want to try although you will not get 1:1 macro.

MANUAL BRACKETING, OLYMPUS FOCUS BRACKETING AND FOCUS STACKING

OLYMPUS FOCUS BRACKETING / STACKING

FOCUS BRACKETING / STACKING BASICS

Not all cameras support Focus Stacking, which is different to Focus Bracketing, but what are the
differences?

Cameras supporting Focus Stacking: 

OMD EM-10 (MKII MKIII, MKIV) 

OMD EM-5 (MKII, MKIII) 

OMD EM-1 (MK1 �rmware v4, MKII, MKIII) 

OMD-EM 1X 

OMDS OM-1

Manual Bracketing as required. Focus Bracketing from �rst point back. 2-9 Number of frames in front of 1st
Focus Point when Focus Stacking, depending on Focus Differential, Aperture and number of frames.
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User selected 3-999 frames, with Focus Offset
user selected from 1-10. 

Frames will recede from the �rst focus point
back into the scene. 

Will require blending afterwards.

Raw/Jpeg according to your settings. 

FOCUS BRACKETING

User selected 3-15 frames with Focus Offset
user selected from 1-10. 

Further frames are captured in front of the 1st
focus point in the order show. In-camera
stacked image is Jpeg only* and will cropped
by approx 10% but will have the original pixel
dimensions. Raws are saved but not stacked.

Raw/Jpeg* according to your settings. 

FOCUS STACKING

Raw/Jpeg according to your settings. 

MANUAL BRACKETING

MANUAL BRACKETING

FOCUS BRACKETING

You choose number of frames and where to focus. 'Focus Offset' or distance between is your
choice and the order of frames is under your control. 

Used mainly for landscapes. Will require blending afterwards.

Not recommended for Macro as we have built in features, but let's not forget back in the day all
the images we shoot now were still being taken with manual skills. 
For macro a slider would have been used to move the camera minute steps rather than the
focus point. 
I have included it here because for landscapes if I do need to focus bracket I will just do it
manually, moving the focus point where I need for 2 or three frames ad then blending them in
Photoshop.

(Recommended for Glowing Shrooms) 
Automated in-camera, set the number of frames and the Focus Offset, the camera will enter
Continuous Silent drive mode and you're good to go. make sure you shoot in Raw for processing
later. The challenge is to make sure the Focus Offset is correct, or how far apart the focus will
shift to cover the front and back of the subject. 

There are no set parameters for this, considering all the variables it would be impossible to have
a chart expressing distances, offsets, frames, etc, so it's guesswork and experience. 
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As above, set the frames, the Offset and the camera will take all the shots in Continuous Silent.
There are some major differences to Focus Bracketing, the main being that the camera will
produce an in-camera stacked image of all the frames but in Jpeg only and the available frames
are reduced to 15 as a result (all the frames are saved according to your settings Raw and/or
Jpeg). 

FOCUS STACKING

Practice and take test shots as outlined in the Shooting section, I tend to use Step Size 1 for
small subjects and Step Size 2 if the subject is larger. 
Next is the number of frames, you may need 10 or 20 or more. What matters is capturing the
front and the rear details with enough frames in-between to include the detail of the steps and
the gills. Too many frames is �ne, they can be delated back home, not enough is a problem.

The number of frames and the offset depends on how big the subject is and how close you are.
Considering we are dealing with subjects that may be just a few mm diameter, or a few inches,
you will only need to consider a step size of 1 or 2, rarely 3. 

The image is also cropped slightly to around 90% of the original but is then resampled back up
to the original pixel size, and at the time of shooting a frame will show on the screen as a guide
for composition. 
This is to account for 'Focus Breathing' where as the focus is moved objects in the scene can
change in size due to the �eld of view changing, which is more apparent in very close focus
subjects such as Macro. It's the reason it is important to 'align' image sets in post before they are
blended. As Focus Stacking produces a stacked image the frame shows how the image will be
cropped to remove the edges that will not align successfully. With Focus Bracketing there is no
such guide frame so you need to be aware of it when composing your scene. 

Note that a number of images in total is limited to 15, with a number receding from the focus
point and a number in front of the focus point with the second shot stepping forwards �rst. The
number of images in front of the focus point, 2-9, depends on the focus differential or how wide
the 'steps' are, aperture and total frames set. 
Focus Stacking can be a little unpredictable, trial and error are needed and experience will
guide you. You are better to shoot Glowing Shrooms in Focus Bracketing and not Stacking
mode. 

The stacked image is Jpeg and we want raw so it is redundant, although the frames will be
recorded in Raw (make sure you have Raw set). The frames are limited to 15, which may be
enough, but the second frame will step forwards with a number of additional frames
(depending on the number set and the step size) captured forwards of your focus point. 
This works �ne in many Macro images but can cause us a problem for Glowing Shrooms. 
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If you are using a non macro lens such as the 12-40 f2.8 Pro do not rely on the clutch to
switch between auto and manual focus and retain the same focus, if often disturbs it. I often auto
focus, I �nd it easier the shooting landscapes, but then if I want to enter manual I never pull the
clutch back, the focus more often than not is disturbed. See below:

→ TIP

As I said in the Shooting section we need to manually focus on the subject on the front edge.
There's nothing wrong with auto-focusing but do switch to manual to �ne tune it and make
sure you have Peaking (edges in focus are highlighted) enabled. 
The 60mm Macro lens doesn't have a manual focus switch or a clutch so we need a way to
enable manual focus. Luckily there are a number of ways.

Your rear screen makes it very easy to adjust settings, just select the focus mode and change it.

You may already use BBF. Back Button Focus separates the shutter button from focus, using a
rear button for focus instead. It means you have manual focus and easy access to auto focus. 

MANUAL FOCUS

SUPER CONTROL PANEL

BACK BUTTON FOCUS

Fn LEVER

Your focus point will need to be set into the subject to compensate for the forward focus frames,
but where? An amount into the gills, on the stem? What if your shroom is sideways on and you
can't see the gills? And if you do focus partly into the subject there is a danger that the forward
frames will not capture the front edge. Try it by all means but it is much easier just to use Focus
Stacking.

It can be quite handy because it means the shutter will not disturb focus when pressed, useful
in this situation and others such as when using external ND �lters or shooting panoramics. The
EM-1 MKIII shipped with BBF already set up (AEL/AFL button) and the OM-1 has the dedicated
AF-ON button. 
Once in Manual Focus these buttons act as an auto focus button. Set your camera for BBF if not
already and if it sounds like a feature you'd like.

The Fn Lever is often overlooked and can be set for various focus modes and the focus target
size can be set for each too. 
For instance in Position 1 you could have a small AF target size and Single AF, then in Position 2
have a cluster target size with Continuos AF plus Tracking. 
Therefore if you don't have or want to set BBF you could just set MF (Manual Focus) to Position
2. 
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Set MF to a button. Since the days of the E-M 10 and E-M 5 I have always customised the rear
Direction Pad. Instead of it just moving the focus point it can be customised for additional
functions without losing the original function. 

Before we look at settings for shooting Glowing Shrooms a word about Custom Modes and My
Sets. Depending on your camera they may be My Sets or CM's and they do the same thing,
saving a group of settings for use in particular situations for quick recall. 

MAP A BUTTON

CUSTOM MODES / MYSETS

Setting it is very easy, just set the lever to the position required, change the relevant settings 
and it will be stored in the camera memory. Check your lever though, on some cameras there 
can be a difference in stiffness and you really do not want to have to push hard, and disturb the 
camera. My MKIII was �ne but the MKII was quite stiff. 
The OM-1 Lever is much smaller and quite stiff so I am glad it has a dedicated AF-ON. Note the 
E-M 10 never had an Fn Lever so mapping MF to a button is the only way or just use the Super 
Control Panel.

Once customised the right direction actives the AF Target function and then they all return to
their default 'left, right, up, down' status. In the Button Function Menu go to the D Pad and set it
to Direct Function, then set each to what you would like. 
I usually set White Balance to one, Drive Mode to another and MF to the right direction button. 
It's handy to have quick access just using my right hand to functions I want to use often. Note in
the E-M 1MKIII the option for MF was strangely removed, so use one of the other options above.

This is not a guide on setting up Custom Modes, I covered it in the OM-1 Guide but the
principles are the same. I set up the basics for each CM depending on the genre or situation and
set up Custom Buttons too. 

The advantage is obviously quick recall, and any settings you change will return back to the
original saved set once you switch off and on again. It removes the chance of for instance
setting a high ISO only to �nd you used it again unnecessarily on your next session. 

When setting buttons I have a master set which I set �rst and then only change them for each
Custom Mode if I really need to, one thing to avoid is making things too complicated or you just
end up confusing yourself.



77

Above are a few suggestions to think about. My Custom Modes on the OM-1 are different to this
and very similar to how I had them set on the E-M1 MKIII. I have a General Landscapes CM, a
General Manual Mode CM with Live ND mapped to AEL because Live ND is only available in M
or S, and a Wildlife CM I use when the opportunity arises with high shutter speed saved, Auto
ISO and SH2 drive mode set. 

I also have a Live Time CM, which may sound odd at �rst. Olympus made Live Time even easer
to access when Bulb was added to the Mode Dial along with Manual, so using it is just a case of
setting B and using the front wheel to set Live Time. In most cases when I use Live Time I just
set B, but there are times when I do not want noise reduction enabled. Setting a long exposure
of a few minutes at sunset means time is precious if I want to get a few shots so I'd rather deal
with noise in post processing. As I use Live Time much more than I use macro settings (just
Autumn) I have a CM saved with Live Time and noise switched off. I can switch easily between
the two knowing I'm not going to forget to check if noise is on or off. 

This means I don't have any more space for an additional Macro CM, but the standard APSM
setting on the Mode Dial I rarely use because I have all I need saved on Custom Modes. This
means I can set things up how I want for the session in hand, knowing that any changes to
buttons etc will be re�ected across all the APSM modes. But for most situations I am using a
Custom Mode, so as long as you are aware any changes you make in APSM will be global across
each, you can actually expand your saved settings because the camera remember settings set
in APSM. 

For example, I already said I save Live ND (one available in M or S) to the AEL button (a button I
have little use for) in Manual Mode and have this saved along with other settings as a Custom
Mode. I generally shoot landscapes in Aperture Priority (never let anyone tell you a 'proper'
photographer uses M because it's rubbish, there's little difference), but when I want to use Live
ND I just swap to my Custom Mode which was save as M. 

Now on the Mode Dial I have little use for APSM so for shooting Macro I swap to M and then
have AEL set to Magnify (I explain why below). AEL is now set to Magnify across A, P, S and M
and also B. But as the only mode I use is B it doesn't matter at all.
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Mysets are still current on E-M5's and they are a little different in that there is no speci�c location they
can saved to on the Mode Dial. And they are a little more complicated to set up. First set your settings
and then save them as a Myset in Shooting Menu 1 > Reset/Myset.

We can set up a few buttons and settings ready for the session and to make things a little easier. You
can also save this as a Custom Mode or a Myset if you wish. I won't list the menu positions because
they have changed across different camera bodies but the naming remains the same. 

MYSETS

BUTTONS & SETTINGS

Set each of the 4 available as required, but don't select  for obvious reasons. 
Next you have to tell the camera how to access them in 

. 
Select the Myset and save it on the Mode you want to use to access it. The Scene Mode and Collage
Mode are also available, you may want to preserve Scene Mode but who the Collage Mode is aimed
at I have no idea. 

Reset
Custom Menu > Button/Dial/Lever > Mode

Dial Function

Do keep any Mysets you have saved to the relevant Mode, for instance don't save an Aperture Priority
Myset on Shutter Priority, otherwise you could get con�ict. Changing any settings in a mode that isn't
saved as a Myset will still re�ect across others PASM modes so be aware of it.

RAW - Make sure you have RAW set for the image quality, we need the Raw �les for processing, and
set the Aperture to f2.8. 

FOCUS PEAKING - Set Focus Peaking on to highlight edges when manually focusing. Set the colour
you prefer, I prefer white, set Highlight Intensity to Normal, and leave Image Brightness Adj off. Then
in MF Assist set Magnify to ON. When manually focusing the view will zoom in to enable detailed
inspection. 

FOCUS BKT - Set Focus Bracketing. These are the OM-1 screens and the settings are the same. Set it
to 10 shots and set the Focus Differential to 1. These are just basic and you'll change them for each
situation.
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Next we can set some buttons which will keep very simple. The actual menu location is different
again but the name is similar Button Function (

)
E-M5 Custom Menu>B Button Dial Lever> E-M1

MKIII Custom Menu >B1>Button Function OM-1 Cog>1.Operations>Button Settings

Custom Buttons example screen for the OM-1

The buttons you choose to customise depend on what Custom Modes you decide to set, and
your camera body, so below I list the buttons I have set on the OM-1 and they can be set on
other Olympus bodies too. If a button is listed as  I applied this just to this Custom
Mode for Macro set.  means I have it set as default across all modes and Custom Menus
and means these are options. I am presuming you will use these as a CM or a
MySet. 

(this CM only)
(Global)

 (Suggested) 

Remember I just set it up on Manual Mode because I have used all my Custom Modes. I
changed the Record button to Focus BKT which removes the default Hand Held Hi-Res
function. This is a function I use often, but as I use it for landscapes and I have a CM saved
already for this it doesn't matter to me that I change the default  settings. In other words I
will set up settings on PASM for given situations temporarily, knowing all my main settings are
saved and protected on Custom Modes.

PASM
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These are fairly simple and all I need to help me when shooting Macro. I'll go though them to
explain a little more.

Applying it to a button gives quick access to switch it on and off, and pressing/holding the
button down reveals the settings menu for Focus Bracketing. Of course you could instead save
this to My Menu instead for quick access. On the OM-1 I've changed the default Hi Res setting
but tat doesn't matter because its still saved as default in my Custom Modes.

Magnify as the name suggest allows me to zoom into the scene to inspect details. Focus
Peaking does the same but the important difference is I can do it without touching the focus
ring after I've painstakingly set focus.

(Boost on other bodies). This boosts contrast which can be handy to for better visibility in lower
light. I have this set as a Global default button.

A Global default button. This is very useful to separate peaking from the manual focus. When
manually focussing you should have set the camera to zoom into the view which is needed, but
sometimes it can be annoying too. 

Optional, as already discussed above. A way to focus to Manual is needed, and you can use the
Lever if there is one, the D Pad, or indeed just the Super Control Panel.

FOCUS BKT

MAGNIFY

NIGHT LV

PEAKING

MANUAL FOCUS

If I'm shooting a landscape and just want to view the whole scene and what is in focus without
zooming in I can just press the Peaking button. 

Also, press Peaking �rst and then manually focus and the view will stay as the normal view.
Activating Peaking �rst disables the zooming in feature which can be really handy. Note the E-
M5 has only one button on the front so I would ignore Boost and give Peaking Priority.
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Those are all the settings you need. Once you set up the basics, set up Focus Bracketing, set a
few buttons and then save as a Custom Mode if desired, then you're all set to start shooting.

CONCLUSION

Follow the guide in the Shooting Technique and the Processing Technique and you're sure to
get some great images. 

Happy Shrooming.
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